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Update Instructions for Mac OS TIP The Updater installs XTensions™ in the “XTension” folder

1 Before updating, make a copy of the QuarkXPress folder cur- within the QuarkXPress application folder. If, after updating,

rently on your hard drive. This ensures that you will have a you decide you do not want to use some of these XTefl?l?ns'
working copy if the update is unsuccessful you can disable them with the XTensions Manager (Utilities >

XTensions Manager).
2 Disable any virus protection software before updating. If

you are concerned about a virus infecting your computer, we

recommend that you first run a virus check on the CD-ROM or
the downloaded files. Then disable your virus detection before
updating.

TIP If the Updater replaces any QuarkXTensions™ software,
it places the older versions of these files in a folder named
“Old Items Folder” (in the application folder).

3 Use an extensions manager to disable non-essential system
extensions. Do not disable system extensions or control panels
required for accessing the CD-ROM drive.

4 If you are updating from a CD-ROM, insert the CD-ROM.
(If your computer does not have a CD-ROM drive, you may
use a networked CD-ROM drive and mount that drive over
the network.)

5 Double-click the Updater icon. The Select QuarkXPress™
to Update dialog box displays.

6 Locate and select the copy of the application you want to
update.

7 Click Open to update the application.
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Update Instructions for Windows

1 Before updating, make a copy of the QuarkXPress folder
currently on your hard drive. This ensures that you will have
a working copy if the update is unsuccessful.

2 Disable any virus protection software before updating. If
you are concerned about a virus infecting your computer, we
recommend that you first run a virus check on the CD-ROM or
the downloaded files. Then disable your virus detection before
updating.

3 If you are updating from a CD-ROM, insert the CD-ROM.
If your computer does not have a CD-ROM drive, you may
use a networked CD-ROM drive and mount that drive over
the network.

4 Double-click the “Update.exe” file. The Select
QuarkXPress™ Drive & Directory dialog box displays.

5 Locate and select the copy of the application you want to
update.

6 Click Update to update the application.

TIP Some QuarkXTensions software and language files have
been updated. If you have any of these items installed, the
Updater will automatically replace them with updated versions.

Page 15
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Problems Resolved in This Version

NOTE Additional fixes may have been included at the last
minute. For complete information on fixes contained in this
version and for fixes incorporated from the 4.05 Updater, visit
the Quark™ Web site at www.quark.com/quarkxpress or
www.quark.co.jp.

e The Kern-Track Editor QuarkXTensions software now accepts
new Kkerning pairs consisting of a character and a space.

e [tems in the Print dialog box Printer Fonts tab can now be
multiple-selected.

e Saving a vertical layout document as EPS with Spread checked
no longer results in the wrong pages being saved.

e Importing an XPress Tags file that contains more than two
rubi in a row no longer causes a crash.

e AppleScript now correctly returns the offset of 2-byte
characters.

e AppleScript now counts control characters (return, tab,
space, etc.) when counting characters.

e Japanese punctuation (tenmaru) now displays and prints
correctly in vertical layout when character scaling is applied.

e Colors named with 1-byte katakana and saved in an EPS file
(either from QuarkXPress, Illustrator, or a Photoshop duotone)
are now added to the Colors palette when the picture is
imported into QuarkXPress.

e The Undo command now works correctly with 1-byte text.

* Measurements palette display has been corrected for docu-
ments that only contain text on a path.

¢ Incorrect characters are no longer entered using the Moji
palette in ATOK12.

e The correct Kanji characters now display in the Page pop-
up menu.

e The More Information area of the Usage dialog box Fonts
tab (Utilities menu) now displays information about PostScript
fonts correctly.

e Text with multiple trap relationships can now be changed as
a group to any other trap relationship.

e Applying a non-drop cap style to a paragraph with local drop
cap formatting no longer causes the paragraph to disappear.

* C(licking Update in the Usage dialog box Pictures tab (Utilities
menu) now updates all images located within the same folder.

e TIFFs with embedded paths now default to Item in the
Type pop-up menu of the Modify dialog box Clipping tab, as
the application no longer assumes embedded paths in TIFF
images are to be used for clipping. However, if a path within a
TIFF image is designated as a clipping path, the application
will default to Embedded Path for that image.

* QuarkXPress no longer crashes when editing text with
different trap relationships.
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* QuarkXPress now dynamically updates the X and Y coordi-

nates in the Measurements palette when resizing a picture box.

¢ Collect for Output (File menu) now includes Style Sheet
Characters and Formats in the Document Report.

e When a picture containing a clipping path is replaced via
Usage (Utilities > Usage > Pictures tab) with a new picture
that also contains a clipping path, the old picture’s clipping
path information is no longer retained.

e The placement of a line arrowhead, as shown in the Measure-
ments palette, is no longer dependent on where the line starts
and ends, but rather whether the right arrowhead or left arrow-
head is chosen.

e When an image with a clipping path is imported, the clip-
ping path is no longer subject to the QuarkXPress Smoothness
and Noise default of 2 points (formerly displayed in Item -
Modify > Clipping tab).

e When using Open Prepress Interface (OPI), clipping and
displacement of images on the black plate has been fixed.

¢ QuarkXPress now correctly recognizes the Euro character
when a QuarkXPress document is moved from Mac OS to
Windows, or vice versa.

e When entering a number followed by a dash (-) in the Pages
field of the Print dialog box (File menu), QuarkXPress now
prints to the end of the document instead of displaying the
message, “Improper number or measurement.”

* QuarkXPress no longer prompts for the document to be saved
after it has been printed but not edited.

e For new documents, the Include Preview checkbox in the
Save As dialog box is checked by default. The state of this
checkbox is saved with the document.

e Pictures no longer display a status of Modified in the Usage
dialog box (Utilities >~ Usage > Pictures tab) after saving a
version 4.0 document as a version 3.3 document.

* You can now access a Master Page in documents containing
2,000 pages.

e Pages containing .5 point vertical lines that are saved as an
EPS and then reimported now display and print correctly.

* (Mac OS only) High resolution, LZW compressed TIFFs now
display and print correctly.

* (Mac OS only) QuarkXPress no longer crashes under
Mac OS 8.5 or later when double-clicking the Lists palette.

¢ (Windows only) When opening a document created in
QuarkXPress for Mac OS in QuarkXPress for Windows, the
correct file version is now recognized.

* (Windows only) Text that has an applied Baseline Shift (Style
menu) that was exported from QuarkXPress as Rich Text Format
(RTF) no longer imports into QuarkXPress (or other applications)
with an incorrect Baseline Shift amount.
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¢ (Windows only) Modification dates are now displayed prop-
erly after you edit and re-save a document that has been saved
to an NTFS or Novell partition on a server.

e (Windows only) After a new document is created and closed,
QuarkXPress no longer crashes when exiting the Dashes &
Stripes dialog box (Edit menu).

¢ (Windows only) Imported Rich Text Format (RTF) files no
longer lose paragraph formats.

e (Windows only) When selecting the bottom text box in a
stack of text boxes that contain a background color of None,
QuarkXPress now redraws correctly.

e (Windows only) Re-saving a document in version 4.0 format
no longer generates the “Access Denied” error when saving to a
Novell network.

e (Mac OS only) The erroneous message “Can’t find required

volume or folder” no longer displays after you click Cancel in

the Open dialog box (File menu) and then attempt to save the
current document.

* (Windows only) The application no longer crashes when a
TIFF using Non-White Areas clipping (Item - Modify >
Clipping tab) is updated to an EPS (Utilities >~ Usage —
Pictures tab).
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Compatibility Issues

Adobe Type Manager (ATM) and CID fonts

A crash can occur when using certain CID Type 1 fonts while
ATM is active. This occurs most frequently when characters are
rotated, skewed, or scaled. On Mac OS, this can be fixed by
updating to ATM 4.5.1, which you can download from the
Adobe Web site at www.adobe.com.

Japanese font metrics changes (Mac OS 8.6 only)

The height of characters in Apple's Japanese fonts is different in
Mac OS 8.6 than it was in Mac OS 8.5x. This can cause prob-
lems displaying text in documents and menus, and editing or
printing text. To resolve this problem, download and install the
Font Manager Updater extension from the Apple Web site at
asu.info.apple.com.

Scan Now (Mac OS only)
The Scan Now button (File -> Print -> Printer Fonts tab) does
not work correctly with some print servers.
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Feature Information

Network Hardware Key Technology

A network hardware key is now available. This technology
allows Multi-Pak and Lab-Pak users to run QuarkXPress 4.1
Japanese without an individual hardware key on each com-
puter. The network hardware key technology is currently
designed to run on Windows 95, Windows 98, Windows NT,
and Mac OS.

If you are a Multi-Pak or Lab-Pak user and need more informa-
tion about the network hardware key technology, contact your
local Quark office or Quark Full Service Distributor (see the
"Contacting Quark" section of this document).

Replace Font

Plain, bold, and italic buttons were added to the Replace Font
dialog box in QuarkXPress 4.05 Japanese (Utilities >~ Usage —
Fonts tab - Replace button). To replace the font or fonts
selected in the Current Font field list with a plain, bold, or
italic version of the font selected in the Replacement Font
field, click the appropriate button before clicking OK. You can
simultaneously select the bold and italic buttons.
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Documentation Errata

* A Guide to QuarkXPress incorrectly states that the picture scale
range is 0% to 1000%. The picture scale range should be listed
as 10% to 1000%.

e A Guide to QuarkXPress incorrectly states the default for
Off-screen Draw is unchecked (Application Preferences dia-
log box Display tab). The default setting for Off-screen Draw
is checked.

e A Guide to QuarkXPress incorrectly states that jump lines must
be placed in text boxes that are grouped with the text box they
reference. Text boxes containing jump lines only need to touch
the text box they reference.

e A Guide to QuarkXPress incorrectly states that color and shade
values can be applied to shadows and middles tones of color
pictures. Color and shade values can be applied to black-and-
white and grayscale pictures.

e (Windows 95/98/NT only) A Guide to QuarkXPress incorrectly
states that QuarkXPress 4.0 can import CGM files and HPGL
files. These filters were not updated for use with QuarkXPress
4.0 or later and QuarkXPress Passport 4.0 or later.
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In Japan

For technical support of QuarkXPress in Japan, contact Quark
Technical Support at 03-3476-9440 between the hours of 9:00 a.m.
and 5:00 p.m.

For product and technical support information, visit the Quark
Web site at www.quark.co.jp.

In the Americas

If you are under a technical support plan, or want to purchase
a technical support plan, contact Quark Technical Support at
303.894.8899 between the hours of 7:00 a.m. and 6:00 p.m.
Mountain Time. For additional information on technical support,
see the technical support file on your QuarkXPress CD-ROM.

For e-mail support of QuarkXPress, send a message to
MacTech@quark.com or WinTech@quark.com.

For product and technical support information, visit the
Quark Web site at www.quark.com.

All Other Countries

If you are under a technical support plan, or want to purchase
a technical support plan, contact your local Quark office or
Quark Full Service Distributor.

For a list of Quark Offices and Quark Full Service Distributors,
see the technical support file on your QuarkXPress CD-ROM.

For the most current list of Quark offices and Quark Full Service
Distributors, click the “Contact Quark” link on the Quark Web
site at www.quark.co.uk.

For product and technical support information, visit the Quark
Web site at www.quark.co.uk.

For e-mail support of QuarkXPress, send a message to tech-
support@uk.quark.ch or to MacTech@quark.com or
WinTech@quark.com.
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Legal Notices

©1986-1999 Quark Technology Partnership. All rights reserved.

The information in this document may not be modified, dis-
tributed, or disseminated in paper or electronic form without
prior written consent of Quark Technology Partnership or its
licensee, Quark, Inc.

Quark, QuarkXPress, QuarkXTensions, and XTensions are trade-
marks of Quark, Inc. and all applicable affiliated companies,
Reg. U.S. Pat. & Tm. Off. and in many other countries. The
Quark logo is a trademark of Quark, Inc. and all applicable affil-
iated companies.

Color Data is produced under license from Dainippon Ink and
Chemicals, Inc.

All other trademarks are the properties of their respective owners.
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